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Overview 

The Program Evaluation Toolkit Calculator is a free Microsoft Excel add-in that serves as a 

statistical tool for multivariate descriptive data and regression analysis. It was developed to 

accompany an online course for program evaluation. This user’s guide provides an overview of 

the features in the Program Evaluation Toolkit Calculator as well as additional details and 

definitions.  

In Version 1.3 of the Program Evaluation Toolkit Calculator, the following user-friendly ribbon 

controls every aspect of generating, navigating, and presenting your data analysis.  

 

The first four buttons on the ribbon—“Select Data,” “Transformations,” “Dummy Variables,” 

and “Interactions”—allow you to select and preprocess the data elements in a dataset. The next 

three buttons—“Descriptive Statistics,” “Correlation Matrix,” and “Linear Regression”—allow 

you to analyze the data and perform regression analysis. The “Instructions/Help” button provides 

you with an abbreviated set of instructions on how to use the tool.  

Getting Started 

Loading the ToolPaks 

To ensure that the Program Evaluation Toolkit Calculator operates optimally, first confirm that 

the Analysis ToolPak and Analysis ToolPak – VBA add-ins have been loaded in Excel. The 

Microsoft Office support site has detailed directions on how to load these ToolPaks here. 

Once the ToolPaks have been loaded, launch the Program Evaluation Toolkit Calculator by 

either opening the associated XLAM file or installing it on the Excel Add-ins menu. To access 

the Add-ins menu, go to the “File” tab, select “Options,” and click the “Add-ins” category. On a 

PC, a newly downloaded file must be unblocked before it will work (see the “Access” section 

below), and the macro security level in Excel must be set to “disable all macros with 

notification.” 

When the tool is running, a “Program Evaluation Toolkit Calculator” tab is added to the menu 

bar at the top of Excel. Clicking the tab reveals the ribbon pictured above.  

Preparing the Dataset 

To analyze data and perform regression analysis, first open and prepare your dataset. The only 

requirements are that all variables have the same number of elements and that variable names 

appear in row 1 of your data worksheet. 

mailto:RELCentral@marzanoresearch.com
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If a dataset has rows with missing values, the Program Evaluation Toolkit Calculator will only 

analyze data and perform regression analysis on complete cases (that is, it will only include rows 

with no missing values). 

Access 

Some external XLAM files are automatically blocked due to system settings. If you have trouble 

accessing the Program Evaluation Toolkit Calculator, right-click the XLAM file in Windows 

Explorer and choose “Properties.” In the “General” tab, select “Unblock,” and then click 

“Apply” to have full access to the tool (figure 1). 

Figure 1. Unblocking the Program Evaluation Toolkit Calculator 

 

If you encounter a run-time error “1004” message, confirm that the Analysis ToolPak and 

Analysis ToolPak – VBA add-ins have been loaded in Excel and are currently enabled with a 

checkmark in the “Excel Add-ins” dialog box on the “Developer” ribbon. If the “Developer” 

ribbon is not visible to you, you can add it by clicking on the “File” tab, click on “Options”, and 

click on “Customize Ribbon.” Under “Main Tabs,” check the box next to “Developer.” If the 
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“1004” error still appears after loading and enabling both ToolPak add-ins, try disabling both 

add-ins by deselecting them in the “Excel Add-ins” box on the “Developer” ribbon, clicking 

“OK,” and closing Excel. Finally, restart Excel and enable the ToolPak add-ins again.  

If the above steps do not resolve the “1004” error, click on the “File” tab, click on “Options,” 

and click on “Add-ins.” By “Manage” click “Go…” check the box next to “Analysis ToolPak” 

and “Analysis ToolPak – VBA,” and click “OK.” 

If the above steps do not resolve the “1004” error, add an explicit reference to the atpvbaen.xls 

file in the Analysis ToolPak. To do this, click the “Visual Basic” button on the “Developer” 

ribbon in Excel. When the window opens, click the “Tools” tab and then select “References.” 

Scroll down the list and check the box next to “atpvbaen.xls,” but do not deselect any other 

options that are checked. Finally, click “OK.” 
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Using the Program Evaluation Toolkit Calculator 

This section explains the functionality of the Program Evaluation Toolkit Calculator. Each 

subheading corresponds to a button on the ribbon. 

Select Data 

Clicking the “Select Data” button highlights all variable names and data elements in the dataset. 

You will be informed that variable names were created from the top row of the selected data.  

The tool allows missing values for data elements but will prompt you if any variable names are 

missing.  

Transformations 

Transformations are commonly used to make non-normal data fit the normality assumption of 

regression more closely.  

Clicking the “Transformations” button on the ribbon opens a dialog box with a drop-down list of 

all numeric variables that can be transformed and radio buttons for five mathematical 

transformations: 

 

After selecting a variable and a mathematical transformation, click “Transform Variable.” A new 

column of data is created for the newly transformed variable. This new column is inserted next to 

the column of the parent variable on the data worksheet (for example, “age.Sqr”). 

Dummy Variables 

To incorporate a qualitative predictor (also known as a categorical predictor or factor) into your 

regression model, first create an indicator or dummy variable. A dummy variable has only two 

possible values: 0 and 1. Once created, the dummy variable has numerical values, so it can be 

included alongside quantitative predictors in your regression model.  

Clicking the “Dummy Variables” button on the ribbon opens a dialog box with a drop-down list 

of all categorical variables. Select a categorical variable from the drop-down list and click the 

“Create Dummy Variable” button. This results in a new 0-1 column for each value of the 

selected categorical variable. For example, creating dummy variables for a “SchoolType” 

column that contains two unique values—“Elementary” and “Secondary”—results in two new 0-

1 variables: “SchoolType.Eq.Elementary” and “SchoolType.Eq.Secondary.” Elementary schools 
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in the file will have “SchoolType.Eq.Elementary” equal to 1 and “SchoolType.Eq.Secondary” 

equal to 0. Conversely, secondary schools in the file will have “SchoolType.Eq.Elementary” 

equal to 0 and “SchoolType.Eq.Secondary” equal to 1.  

You can create dummy variables for any categorical variable with 12 or fewer unique values. 

Interactions 

Clicking the “Interactions” button on the ribbon opens a dialog box where you can select any two 

numeric variables between which an interaction effect can be applied via multiplication. The new 

column of data for the interaction is inserted on the data worksheet, and the corresponding 

variable name includes both variables included in the interaction (for example, 

“age.Times.bmi”). 

Descriptive Statistics 

Clicking the “Descriptive Statistics” button on the ribbon allows you to generate a new 

worksheet containing a table of descriptive statistics based on selected variables from the dataset. 

The calculations include all rows containing complete cases for the selected variables, and the 

descriptive statistics include mean, standard error, median, mode, standard deviation, sample 

variance, skewness, range, minimum, maximum, sum, and count. 

Correlation Matrix 

Clicking the “Correlation Matrix” button on the ribbon allows you to generate a new worksheet 

displaying the lower-left triangle of the correlation matrix for the selected variables from the 

dataset. The correlation matrix is based on all rows containing complete cases for the selected 

variables. 

Linear Regression 

Clicking the “Linear Regression” button on the ribbon allows you to specify a dependent 

variable and independent variables on which to run regression analysis for all complete cases in 

the dataset.  

Regression Statistics 

For each model, a numbered Model worksheet is created that includes the following: 

R-SQUARED: R-squared is the fraction by which the sample variance of the model’s 

errors is less than the sample variance of the dependent variable. That is, R-squared is the 

fractional reduction in error variance compared to what would be obtained with a 

constant-only model. It is equal to 1 minus the square of the sample standard deviation of 

the errors divided by the sample standard deviation of the dependent variable. 

R-squared is the proportion of variance in the dependent variable that is explained by the 

independent variables in the model. 
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There is no absolute standard for an acceptable value of R-squared. The value depends on 

the nature of the data, the variance-changing transformations (if any) that have already 

been applied to the dependent variable, the decision or inference context in which the 

model is to be used, and the reasonableness of the model’s assumptions in that context. 

If the context is one in which the model equation is given (as in a designed experiment) 

and interest centers on whether the effects of independent variables are non-zero rather 

than on their predictive accuracy in individual cases, then a low value of R-squared may 

not be a cause for concern. The F-statistic may be relatively more important in that case. 

• F-STATISTIC: F-statistics can assess multiple coefficients simultaneously and help 

answer the question “Is at least one predictor useful?” The F-test of the overall 

significance compares a model with no predictors (also known as the intercept-only 

model) to the model you specify. 

The formula for the F-statistic incorporates the residual sum of squares (RSS; the sum of 

squared errors of prediction) and total sum of squares (TSS; the total variance in the 

outcome or dependent variable), as well as the number of observations (n) and predictors 

(p). 

(TSS − RSS)/p
F =   

RSS/(n − p − 1)

where TSS = Σ(yi - ȳ) 2 and RSS =  Σ(yi - ŷ)2. 

• RESIDUAL STANDARD ERROR: “A fitted regression model uses the parameters to 

generate point estimate predictions, which are the means of observed responses if you 

were to replicate the study with the same X values an infinite number of times (and when 

the linear model is true). The difference between these predicted values and the ones used 

to fit the model are called “residuals,” which, when replicating the data collection 

process, have properties of random variables with 0 means. 

The observed residuals are then used to subsequently estimate the variability in these 

values and the sampling distribution of the parameters. When the residual standard error 

is exactly 0, the model fits the data perfectly (likely due to overfitting). If the residual 

standard error cannot be shown to be significantly different from the variability in the 

unconditional response, then there is little evidence to suggest the linear model has any 

predictive ability.”1

1 AdamO. (2013, April 30). A fitted regression model uses the parameters to generate point estimate predictions 

which are the means of observed responses [Comment on the online forum post What is residual standard error?]. 

StackExchange. https://stats.stackexchange.com/questions/57746/what-is-residual-standard-error.  

 

• OBSERVATIONS: This is the count of complete cases in your dataset that include the 

dependent variable and all independent variables. 
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• COEFFICIENT: The coefficient of an independent variable is the change in the predicted 

value of the dependent variable per unit of change in that variable, holding the other 

variables fixed at any values of their own. In a multiple regression model, the value of the 

coefficient depends to some extent on which other variables are included, and its 

magnitude or sign may change if other variables with which it is correlated are added or 

removed. 

In all linear regression models, the intercept has the same definition: the mean of the 

response, Y, when all predictors equal 0. The intercept is not always meaningful because 

there are cases in which some predictors in the model do not have any values near 0.2

2 Grace-Martin, K. (n.d.) How to interpret the intercept in 6 linear regression examples. The Analysis Factor. 

https://www.theanalysisfactor.com/interpret-the-intercept/.  

 For 

instance, when using retirement age as a predictor to estimate social security benefits, the 

retirement age has a minimum value of 62.   

The coefficient is measured in units of the dependent variable divided by units of the 

independent variable, so its value depends on how the variables are scaled as well as on 

the estimated strength of their statistical relationships. 

If the coefficient of an important variable is very large or very small relative to the 

number of digits visible in the cell in all of your models, then, for easier reading of the 

results, you might consider changing its units by rescaling it by several powers of 10 

before doing your analysis. 

• STANDARD ERROR: The standard error is the estimated standard deviation of a 

coefficient from the given sample of data.  

In general, standard error becomes smaller in proportion to 1 divided by the square root 

of the sample size as the sample size increases. Thus, you would expect four times as 

many data to reduce the standard errors of all the coefficient estimates by a factor of two 

(approximately), assuming that the additional data are described by the same model. 

• t-STATISTIC: The t-statistic of an independent variable is its estimated coefficient 

divided by the coefficient’s own standard error—that is, its number of standard errors 

away from 0. The t-statistic value (which has the same sign as the coefficient) is an 

indicator of whether that variable has been found to have a measurably non-zero effect in 

explaining or predicting variations in the dependent variable, in the context of other 

variables included in the same model. 

The t-statistic associated with any variable is model-dependent. Its value may change, 

sometimes significantly, if other related variables are added or removed. Also, the t-

statistic of a variable whose true coefficient is non-zero tends to grow larger in magnitude 

as the sample size increases because standard errors of coefficients grow smaller as the 

sample size increases. 
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A commonly used rule of thumb is that a variable’s contribution to a model is not 

statistically significant if its t-statistic is less than 2 in absolute value—that is, if its 

estimated value is less than 2 standard errors away from 0, which is the approximate 

standard for significance at the 0.05 level. This is not a hard-and-fast rule, but as a 

practical matter the removal of a variable whose t-statistic is much less than 2 in 

magnitude will probably not increase the standard error of the regression by very much. 

• p-VALUE: The p-value of a coefficient is determined from its t-statistic. It is the 

probability of obtaining a t-statistic that is as large or larger in magnitude than the 

observed t-statistic if the true coefficient of that variable is 0 and the model assumptions 

are otherwise correct. Under those assumptions, the distribution of the t-statistic is a 

student’s t distribution, which is almost the same as a standard normal distribution unless 

the sample size is very small.  

A common rule of thumb is that a variable’s contribution is not statistically significant if 

its coefficient’s p-value is greater than 0.05, which indicates that there is a 1 in 20 or 

greater probability of obtaining a value that large in magnitude by pure chance if the true 

coefficient of that variable is 0 and the rest of the model specification is correct. This is 

essentially the same standard of insignificance as having a t-statistic that is less than 2 in 

magnitude. 

It is not required to keep a variable whose p-value is less than 0.05 or remove one whose 

p-value is greater than 0.05, although you should generally avoid including marginally 

significant variables without other supporting logic or design considerations. Sometimes 

a group of variables forms a logical unit that should not be broken up. For example, a 

group of variables might be dummy variables that are used to identify mutually exclusive 

treatments in a designed experiment, or it might be seasons of the year in a time series 

forecasting model. In such cases, you generally do not pick and choose among them 

individually based on their p-values and t-statistics. 

• LOWER AND UPPER CONFIDENCE LIMITS: Lower and upper confidence limits for 

a coefficient estimate are obtained by adding or subtracting the appropriate number of 

standard errors for that confidence level. These limits can be roughly interpreted as 

intervals within which there is a given probability that the true value lies within that 

range. 

95% confidence limits, which are commonly reported by default, are roughly equal to the 

coefficient estimate plus or minus 2 standard errors. You may sometimes want to present 

intervals for other confidence levels, depending on the decision context. For example, a 

50% confidence interval (a coin flip) is plus or minus two-thirds of a standard error. 

Model Summaries 

Clicking the “Model Summaries” button will allow for a side-by-side comparison of model 

statistics for all models fitted to the same dependent variable.  
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The “Model Summaries” worksheet, which is located to the right of all analysis worksheets, is 

updated with every new regression model and provides an audit trail for all models that have 

been fitted in the lifetime of the Excel file, even those models whose output worksheets may 

have been subsequently deleted. It is recommended that you not delete model worksheets to 

maintain the entire audit trail. 

Only models fitted to the same dependent variable are displayed side by side. 

Instructions/Help 

Clicking the “Instructions/Help button” opens an abbreviated set of instructions on how to use 

the Program Evaluation Toolkit Calculator. The current version number of the tool is also 

displayed. 

 

 

Regional Educational Laboratory Central 

Colorado • Kansas • Missouri • Nebraska • North Dakota • South Dakota • Wyoming 

RELCentral@marzanoresearch.com 

mailto:RELCentral@marzanoresearch.com

	Program Evaluation Toolkit Calculator: User’s Guide
	Table of Contents
	Overview
	Getting Started
	Loading the ToolPaks
	Preparing the Dataset
	Access


	Using the Program Evaluation Toolkit Calculator
	Select Data
	Transformations
	Dummy Variables
	Interactions
	Descriptive Statistics
	Correlation Matrix
	Linear Regression
	Regression Statistics

	Model Summaries
	Instructions/Help





